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บทที$ 1 

บทนํา 

1.1 ความเป็นมาและความสําคญัของปัญหา 

  เนื$องดว้ยผูจ้ดัทาํไดเ้ขา้ร่วมการปฏิบติังานที$การท่าเรือแห่งประเทศไทย ซึ$ งเป็นหน่วยงานราชการโดย

ผูจ้ดัทาํได้ปฏิบติัหน้าที$เป็นผูช่้วยแผนกผลิตสื$อของกองประชาสัมพนัธ์ฝ่ายอาํนวยการ มีหน้าที$ในการ

ออกแบบสื$อโฆษณาประชาสัมพนัธ์ดว้ยโปรแกรมการออกแบบตกแต่งภาพ โดยปฏิบติัหนา้ที$ออกแบบสื$อ

โฆษณาประชาสัมพนัธ์ ที$ใชใ้นการโฆษณาประชาสัมพนัธ์ระหว่างการท่าเรือแห่งประเทศไทย และชุมชน

โดยรอบ รวมทัSงออกแบบสื$อโฆษณาประชาสมัพนัธ์ภายในองคก์ร  

 จากเหตุผลดงักล่าว ผูจ้ดัทาํจึงสนใจที$จะทาํรายงานเรื$อง การออกแบบป้ายไวนิลเพื$อใชใ้นการโฆษณา

ประชาสัมพนัธ์โดยใชโ้ปรแกรมการออกแบบตกแต่งภาพ ในงานราชการของการท่าเรือแห่งประเทศไทย 

เพื$อเป็นการเพิ$มประสิทธิภาพผูจ้ดัทาํจึงไดศึ้กษารวบรวมขอ้มูลเพื$อเป็นประโยชน์ต่อตนเองและผูที้$สนใจให้

ทราบถึงวธีิการใชโ้ปรแกรมการออกแบบไดอ้ยา่งเหมาะสม  

 

1.2 วตัถุประสงค์  

 1.2.1 เพื$อศึกษาการออกแบบป้ายไวนิลเพื$อใช้ในการโฆษณาประชาสัมพนัธ์โดยใช้โปรแกรม                          

การออกแบบตกแต่งภาพ ในงานราชการของการท่าเรือแห่งประเทศไทย  

 1.2.2 เพื$อศึกษาขอ้จาํกดัในการออกแบบป้ายไวนิล เพื$อใชใ้นการโฆษณาประชาสมัพนัธ์ในหน่วยงาน

ราชการของการท่าเรือแห่งประเทศไทย  

 

1.3 ขอบเขตของรายงาน 

  1.3.1 เพื$อศึกษาขัSนตอนการออกแบบป้ายไวนิลเพื$อใชใ้นการโฆษณาประชาสมัพนัธ์โดยใชโ้ปรแกรม 

การออกแบบตกแต่งภาพ ในงานราชการของการท่าเรือแห่งประเทศไทยและขอ้จาํกดัในการออกแบบป้ายไว

นิล เพื$อใชใ้นการโฆษณาประชาสมัพนัธ์งานราชการ ของการท่าเรือแห่งประเทศไทย  

 1.3.2 ขอบเขตของการศึกษาเริ$มตัSงแต่วนัที$ 14 พฤษภาคม 2561 ถึง 31 สิงหาคม 2561 ( 16 สปัดาห์ ) 

 

1.4 ประโยชน์ที$ได้รับ 

  1.4.1 ทราบขัSนตอนการออกแบบป้ายไวนิลเพื$อใชใ้นการโฆษณาประชาสมัพนัธ์โดยใชโ้ปรแกรมการ

ออกแบบตกแต่งภาพ ในงานราชการของการท่าเรือแห่งประเทศไทย  

 1.4.2 ทราบขอ้จาํกดัในการออกแบบป้ายไวนิล เพื$อใชใ้นการโฆษณาประชาสัมพนัธ์ในหน่วยงาน

ราชการของการท่าเรือแห่งประเทศไทย 

 



 

 

บทที$2 

ทบทวนเอกสาร และวรรณกรรมที$เกี$ยวข้อง 

 

  จากการเลือกศึกษาการทาํไวนิลเพื3อการโฆษณาประชาสัมพนัธ์ และการใชโ้ปรแกรมแต่งภาพดว้ย

โปรแกรมการออกแบบ สามารถรวบรวมเนืJอหาและเอกสารที3สามารถนาํเอาแนวคิดและทฤษฎี มาสรุปเป็น

หวัขอ้ในการเรียบเรียงวรรณกรรมที3เกี3ยวขอ้งไดด้งันีJ   

 

  2.1 แนวคิดและทฤษฎีที3เกี3ยวกบัการออกแบบป้ายไวนิล 

  2.2 แนวคิดและทฤษฎีเกี3ยวกบักราฟิก 

  2.3 แนวคิดและทฤษฎีเกี3ยวกบัการออกแบบสื3อ 

 

2.1 แนวคดิและทฤษฎทีี$เกี$ยวกบัการออกแบบป้ายไวนิล 

สิ3งแรกที3ผูอ้อกแบบคาํนึงถึงก็คือการกาํหนดจุดประสงคที์3แน่นอนของงานแต่ละชิJนลงไป เพราะ

ลู่ทางการนาํเสนอข่าวสารมีมากมายซึ3 งทาํให้เกิดความสับสนในการดาํเนินงานที3อาจจะมีการปรับปรุง

เปลี3ยนแปลงอยู่เรื3 อยๆ ทาํให้เกิดการทาํงานที3ไม่เป็นระบบและสิJนเปลือง ปัจจยัต่างๆโดยใช่เหตุ ดงันัJน

ผูอ้อกแบบจึงควรมีหลกัการและขอ้ควรคาํนึงก่อนเริ3มงานวา่ตอ้งการรูปแบบไหนควรใส่อะไรลงไปบา้งโดย

การวางแผนให้รัดกุมงานจะได้สําเร็จลุล่วงไปได้ด้วยดี จนจบสิJนกระบวนการการออกแบบป้ายไวนิล       

โดยการใชโ้ปรแกรมแต่งภาพต่างๆ การออกแบบป้ายไวนิลมีส่วนสาํคญัอยูด่ว้ยกนั 4 ส่วนหลกัคือ 

1. พืJนหลงั พืJนหลงัไดแ้ก่ ส่วนที3เป็นพืJนหลงัทัJงหมด 

2. รูปภาพ ไดแ้ก่ ภาพถ่ายและภาพกราฟฟิก 

3. อกัษร เป็นส่วนของขอ้ความต่างๆ เช่นหวัเรื3องเด่น บอกชื3องานบอกสถานที3 บอกวนัเวลาและชื3อ 

หน่วยงานที3จดัทาํหรือดาํเนินการ 

4. สีการออกแบบสีควรมีความรู้เรื3 องของคู่สีในการออกแบบเพื3อแบบที3 ออกจะไดส้วยงามในที3นีJ จะขอ

แนะนาํใหไ้ปดูไดที้3 www.google.com  

สีพืJน ( Fill ) เป็นเหมือนกบัตวัแทนการทาํงานของพืJนผิวของวตัถุที3ทาํงานทัJงหมด ไม่ว่าจะเป็น                  

พืJนเฟรมของงาน เป็นตน้    



 

 

 รูปภาพ ( Pictures) แบ่งได้เป็น 2 แบบคือ ภาพบิทแมพ(Bitmap)ถ่ายทั3วไป ส่วนภาพเวกเตอร์

(Vector) เป็นภาพที3วาดขึJนด้วยคอมพิวเตอร์นั3นเอง รูปภาพเป็นส่วนประกอบที3สําคญัอนัที3สองในการ

ออกแบบเพื3อดึงดูดความสนใจแสดงประกอบเรื3องราว ให้เกิดความรู้สึกความเขา้ใจคอยตามวตัถุประสงค ์                        

ภาพบิทแมพ(Bitmapped graphics) เป็นภาพกราฟิกที3สร้างขึJนจากการนาํจุดเล็กๆ จาํนวนมากมารวมกนั                 

จะสิJนเปลืองเนืJอที3ในการจดัเกบ็มาก และการขยายภาพใหใ้หญ่ขึJนจะปรากฏรอยหยกั          

 ภาพเวกเตอร์ (Vector Graphics)  เป็นภาพกราฟฟิกที3สร้างขึJนจากสมการทางคณิตศาสตร์ แบบต่างๆ  

ทาํให้ใช้เนืJอที3ในการจดัเก็บน้อย และสามารถย่อหรือขยายภาพโดยที3คุณภาพของภาพไม่เปลี3ยนแปลง                      

ขอ้เสียคือเครื3องตอ้งมีการคาํนวณที3ซบัซอ้นจึงมีการทาํงานชา้กวา่แบบบิทแมพมาก 

 อักษร (Text) เป็นข้อความออบเจ็กต์ชนิดหนึ3 ง ตัวอักษรหรือตัวหนังสือคือเครื3 องหมายที3ใช้             

แสดงความรู้สึกนึกคิดเป็นการเผยแพร่ความรู้ความเขา้ใจ ในความหมายไดอ้ยา่งชดัเจนตวัอกัษรหรือตวัพิมพ ์   

จึงจัดว่าเป็นองค์ประกอบพืJนฐานสําคัญอันดับแรกของการออกแบบการจัดวาง ( Layout Design )                      

การออกแบบจาํเป็นตอ้งมีการเรียนรู้เกี3ยวกบัตวัอกัษร เช่นขนาด ( Type size ) รูปร่างลกัษณะ ( Character ) 

ส่วนประกอบตลอดจนกรรมวิธีการต่างๆ ที3เกี3ยวขอ้งกบัการจด และการผลิตตวัอกัษรเพื3อความเขา้ใจและ

การนาํมาใชอ้ยา่งถูกตอ้งเหมาะสม 

 รูปแบบตัวอกัษร การสร้างสรรค์รูปแบบตัวอกัษรให้สวยงามแปลกตาสอดคล้องกับลักษณะ                 

ของขอ้ความมีความชัดเจนทาํให้เกิดความน่าสนใจมากขึJน การสร้างรูปแบบตวัอกัษรทาํได้ 2 ทางคือ               

การจินตนาการรูปแบบใหม่สําหรับงานนัJนๆ โดยเฉพาะกบัการเลือกใช้อกัษรสําเร็จที3ออกแบบไวเ้ป็น

มาตรฐานทั3วไปสีของตวัอกัษรในการกาํหนดสีใหย้ดึหลกั 3 ประการคือ 

1. ค่านํJาหนกัของสี Tone of Color 

2. สีของตวัอกัษรตอ้งไม่ใชห้ลายสีจนเกินไป 

3. ควรใชสี้ใหเ้หมาะสมกบัคาํหรือขอ้ความนัJนๆ 

 สี (Color) สิ3งแรกที3ควรรู้เกี3ยวกบัเรื3องสี ก็คือการเลือกใชโ้หมดสีใหเ้หมาะกบัประเภทของงานโดย

จะตอ้งมีหลกัการเลือกใชโ้หมดสีอยา่งถูกตอ้ง ตลอดจนรู้ขอ้จาํกดัของสีแต่ละโหมดอีกดว้ยซึ3 งรายละเอียด

ของโหมดสีมีดงันีJ  

1. โหมด Bitmap คือโหมดสีที3มีการเกบ็ขอ้มูลของสี 1 บิตต่อพิกเซล ซึ3งจะแสดงผลไดเ้พียงสีขาวและสีดาํ

เท่านัJนและไม่มีการไล่โทนสีลกัษณะภาพที3ไดจึ้งมีความหยาบเหมาะสาํหรับภาพลายเส้น 

2. โหมด Grayscale คือเป็นโหมดสีขาวดาํที3สามารถไล่โทนได ้256 ระดบั 



 

 

3. โหมด Duotone คือโหมดสีสาํหรับภาพแบบโมโนโทน โดยรูปภาพจะแสดงแบบ grayscale เพียง Channel 

เดียวมีค่า 8 บิทต่อพิกเซล 

4. โหมด RGB Color ( Red Green Blue ) คือโหมดสีที3มีแม่สี 3 สี ไดแ้ก่ แดง เขียว นํJ าเงิน แต่ละสีสามารถไล่

เฉดสีได ้256 ระดบั และเมื3อรวมกนัทัJง 3 สี จากสามารถแสดงสีไดถึ้ง 16.7 ลา้นสี โหมดนีJ จะเหมาะกบังาน              

ประเภทตกแต่งมากที3สุด  

5. โหมด CMYK Color คือโหมดสีที3มีแม่สี 4 สี ได้แก่ Cyan (ฟ้า),Magenta (บานเย็น),Yellow (เหลือง),            

Black (ดาํ) แต่ละสีเกบ็ขอ้มูล 8 Bit เป็นโหมดที3เหมาะสาํหรับงานพิมพม์ากที3สุด 

6. โหมด Lab Color คือโหมดสีเสมือนจริงใชค่้า Lightness แทนความสว่าง มีค่าตัJงแต่ 0 ถึง 100 โดยค่า a 

แทนสีเขียวถึงสีแดง และค่า b แทนสีนํJาเงินซึ3งมีค่า +120 ถึง -120 ใชใ้นงานพิมพร์ะดบัสูง 

 

2.2 แนวคดิและทฤษฎเีกี$ยวกบักราฟิก 

งานกราฟิกเป็นส่วนสาํคญัที3มีบทบาทยิ3งต่อการออกแบบและกระบวนการผลิตสื3อโดยเฉพาะอยา่ง

ยิ3ง  สื3อที3ตอ้งการการสัมผสัรับรู้ดว้ยตา ไดแ้ก่ หนงัสือ นิตยสาร วารสาร แผ่นป้ายบรรจุภณัฑ์ แผ่นพบั 
แผน่ปลิว โทรทศัน์ โฆษณา ภาพยนต ์ฯลฯ นกัออกแบบจะใชว้ธีิการทางศิลปะและวธีิการทางการออกแบบ
ร่วมกนัสร้างรูปแบบสื3อ เพื3อใหเ้กิดศกัยภาพสูงสุดในการที3จะเป็นตวักลางในการสื3อความหมายระหวา่งผูส่้ง
สารและผูรั้บสารวิธีการออกแบบและวิธีแกปั้ญหาการออกแบบ โดยการนาํเอารูปภาพประกอบ ภาพถ่าย 
สัญญลกัษณ์ รูปแบบ ขนาดตวัอกัษร มาจัดวางเพื3อให้เกิดการนําเสนอขอ้มูลอย่างชัดเจนเกิดผลดีต่อ
กระบวนการสื3อความหมาย 

 กราฟิก (Graphic) หมายถึง ศิลปะหรือศาสตร์แขนงหนึ3 งที3สื3อความหมายโดยใช้ เส้น ภาพเขียน

สัญลกัษณ์ ภาพถ่าย ซึ3 งมีลกัษณะเห็นไดช้ดัเจนเขา้ใจความหมายไดท้นัทีและถูกตอ้งตามที3ผูใ้ช้ตอ้งการ 

         คอมพิวเตอร์กราฟิก (Computer Graphics) หมายถึง การสร้างและการจัดการภาพกราฟิกโดย                 

ใช้คอมพิว เตอ ร์การใช้คอมพิว เตอ ร์ส ร้ างภาพ การตกแต่งแก้ไขภาพ ห รือการจัดการ เ กี3 ยว                                                        

กบัภาพ เช่น ภาพยนตร์ วิดีทศัน์ การตกแต่งภาพถ่าย การสร้างภาพตามจินตนาการ และการใชภ้าพกราฟิก                   

ในการนาํเสนอขอ้มูลต่าง ๆ เพื3อให้สามารถสื3อความหมายให้ชัดเจนและทาํความเขา้ใจได้ง่ายกว่าเดิม                 

เช่น การนาํเสนอขอ้มูลด้วยแผนภาพหรือกราฟ แทนที3จะเป็นตารางของตวัเลข ซึ3 งในปัจจุบนัมีการใช้

คอมพิวเตอร์กราฟิกกบังานหลากหลายดา้น ไม่ว่าจะเป็นงานดา้นการศึกษา งานดา้นธุรกิจ งานดา้นการ

ออกแบบ งานดา้นบนัเทิง หรืองานดา้นการแพทย ์เป็นตน้ 



 

 

 การออกแบบ (Design) คือศาสตร์เเห่งความคิดเพื3อให้เกิดความพอใจในด้านต่างๆ เช่น ความ

สวยงาม, ตวัหนงัสือตอ้งอ่านง่าย, มีเเนวความคิดในการออกเเบบที3ดี ตลอดจนการเลือกใชโ้ทนสีที3เหมาะสม

กบังานจะส่งผลใหง้านออกมาสมบูรณ์แบบชนิดสิบปากวา่ไม่เท่าตาเห็นซึ3 งเป็นสาํนวนไทย หมายถึง ไดย้นิ

ไดฟั้งมากสู้็เห็นดว้ยตาตนเองไม่ได ้

 ภาพกราฟิกแบ่งเป็น 2 ประเภท 

1. ภาพเวคเตอร์ (Vector) จะเป็นภาพที3ประกอบดว้ยเส้นลกัษณะต่างๆ เช่น เส้นตรง โคง้ และรูปทรงของ                 

เลขาคณิต จะถูกจัดเก็บในคาํสั3งของโปรแกรมและค่าตวัเลข ซึ3 งเวลาทาํการแสดงผลจะมีการคาํนวณ               

ทุกๆครัJ งส่งผลให้ภาพลักษณะเช่นนีJ มีความคมชัดและไม่แตกเมื3อมีการขยายให้ภาพมีขนาดใหญ่ขึJน 

2. ภาพบิตแมป (Bitmap) จะเป็นภาพที3ประกอบจากจุดสีขนาดเล็กๆจาํนวนมากเรียงเรียงตวักนัในลกัษณะ

รูปแบบตาราง เรียกวา่ พิกเซล(pixel) โดยในแต่ละภาพจะมีค่าและขนาดที3แน่นอน ถา้มีการขยายเพิ3มมากขึJน

จากขนาดเดิมจะทาํใหม้องเห็นเป็นภาพหยาบหรือรูปภาพแตกอยา่งชดัเจน 

ประเภทของไฟลภา์พกราฟิก  

JPEG JPG (JoinPhotographicExportGroup)  

เป็นรูปแบบไฟลที์3เก็บภาพแบบราสเตอร์ที3ไม่ตอ้งการคุณภาพสูงมากนกั เช่น ภาพถ่ายจากกลอ้ง

ดิจิตอลภาพถ่ายจากโทรศพัทมื์อถือและภาพกราฟิกสาหรับแสดงบนอินเทอร์เน็ตสามารถแสดง สีไดถึ้ง 16.7 

ลา้นสี เป็นไฟลภ์าพชนิดหนึ3งที3ไดรั้บความนิยม เพราะไฟลมี์ขนาดเลก็ สามารถบีบอดัขอ้มูลไดห้ลายระดบั  

 GIF (GraphicInterchangeFormat)   

เป็นไฟล์ภาพที3สามารถบีบอัดข้อมูลให้มีขนาดเล็กได้ส่วนมากจะนําไปใช้บันทึกเป็นไฟล์                      

ภาพเคลื3อนไหวและนิยมมากในการใชงา้นบนเวบ็เพจ  

PNG (PortableNetworkGraphics)   

เป็นชนิดของไฟล์ภาพที3นาํจุดเด่นของไฟล์ภาพแบบ GIF และแบบ JPG มาพฒันาร่วมกนั ทาํให้

ไฟลภ์าพชนิดนีJ แสดงสีไดม้ากกว่า 256 สี และยงัสามารถทาํพืJนหลงัภาพให้โปร่งใสได ้จึงเป็นไฟลภา์พที3

ไดรั้บความนิยมมากในปัจจุบนั  

BMP (Bitmap)    

เป็นรูปแบบของไฟลภ์าพมาตรฐานที3ใชไ้ดใ้นระบบปฏิบติัการวินโดวส์โดยมีลกษัณะการจดัเก็บ

ไฟลภ์าพเป็นจุดสีทีละจุดจึงทาใหภ้าพดูเสมือนจริง 

 

 



 

 

TIF หรือ TIFF (Tagged Image File)   

เ ป็นไฟล์ที3 ใช้เก็บภาพแบบราสเตอร์คุณภาพสูง เ ช่น ภาพกราฟิกที3นําไปทํางานในด้าน                                 

สิ3 งพิมพ์ (Artwork) สามารถเก็บข้อมูลของภาพไว้ได้ครบถ้วน ทําให้คุณภาพของสีเหมือนต้นฉบับ                                          

PSD (PhotoshopDocument)   

เป็นไฟลภ์าพเฉพาะโปรแกรม Adobe Photoshop จะทาํการบนัทึกแบบแยกเลเยอร์ (Layer) โดยเก็บประวติั

การทางานและรายละเอียดการตกแต่งภาพ เอาไวเ้พื3อง่ายต่อการแกไ้ขในภายหลงั 

 

2.3 แนวคดิและทฤษฎเีกี$ยวกบัการออกแบบสื$อ 

ปัจจุบนัโลกไดเ้ขา้สู่ยคุเศรษฐกิจฐานความรู้งานต่างๆ จาํเป็นตอ้งใชค้วามรู้มาสร้างผลผลิตให้เกิด

มูลค่าเพิ3มมากยิ3งขึJน การจัดการความรู้เป็นค่ากวา้งๆ ที3มีความหมายครอบคลุมถึงเทคนิค กลไกต่างๆ 

มากมาย เพื3อสนับสนุนให้การทาํงานในองค์กร มีประสิทธิภาพยิ3งขึJน ในการรวบรวมความรู้ที3กระจดั

กระจายอยู่ที3ต่างๆ มารวมไวที้3เดียวกัน ซึ3 งช่องทางบนเครือข่ายอินเทอร์เน็ตนับเป็นอีกช่องทางหนึ3 งที3

สามารถตอบสนองในการเป็นเวที แลกเปลี3ยนเรียนรู้ แบ่งปัน นาํไปสู่สงัคมแห่งการเรียนรู้ที3ย ั3งยนื 

หลกัการออกแบบสื3อเพื3อการเรียนรู้ประกอบดว้ย 9 ขัJนตอน ดงันีJ   

ขัJนตอนที3 1 เร้าความสนใจ (Gain Attention)  

ขัJนตอนที3 2 บอกวตัถุประสงค ์(Specify Objectives)  

ขัJนตอนที3 3 ทวนความรู้เดิม (Activate Prior Knowledge 

 ขัJนตอนที3 4 การเสนอเนืJอหา (Present New Information)  

ขัJนตอนที3 5 ชีJแนวทางการเรียนรู้ (Guide Learning)  

ขัJนตอนที3 6 กระตุน้การตอบสนอง (Elicit Responses)  

ขัJนตอนที3 7 ใหข้อ้มูลยอ้นกลบั (Provide Feedback)  

ขัJนตอนที3 8 ทดสอบความรู้ (Access Performance)  

ขัJนตอนที3 9 การจาํและนาํไปใช ้(Promote Retention and Transfer) 

1. เร้าความสนใจ (Gain Attention)  

สื3อการเรียนรู้ ตอ้งมีลกัษณะที3เร้าความสนใจและดึงดูดความสนใจของผูเ้รียน เพื3อเป็นการกระตุน้และเกิด

แรงจูงใจใหผู้เ้รียนมีความตอ้งการที3จะเรียนสิ3งที3ตอ้งพิจารณาเพื3อเร้าความสนใจของผูเ้รียน 

 

 



 

 

2. บอกวตัถุประสงค ์(Specify Objectives) 

การบอกวตัถุประสงค์แก่ผูเ้รียนเพื3อเป็นการให้ผูเ้รียนไดท้ราบถึงเป้าหมายในการเรียนหรือสิ3งที3ผูเ้รียน

สามารถทาํไดห้ลงัจากที3เรียนจบบทเรียนสิ3งที3ตอ้งพิจารณาในการบอกวตถุัประสงค ์ 

3. ทวนความรู้เดิม (Activate Prior Knowledge)  

ลกัษณะของการทวนความรู้เดิมของผูเ้รียน เป็นการทบทวนหรือการเชื3อมโยงระหว่างความรู้เดิมเพื3อเชื3อม

กบัความรู้ใหม่ สิ3งที3จะตอ้งพิจารณาในการทบทวนความรู้เดิม 

4. การเสนอเนืJอหา (Present New Information) 

การเสนอเนืJอหาใหม่เป็นการนาํเสนอเนืJอหาโดยใชต้วักระตุน้ที3เหมาะสมเป็นสิ3งสาํคญัสาํหรับการเรียนการ

สอนเพื3อใหก้ารเรียนรู้เป็นไปอยา่งมีประสิทธิภาพ สิ3งที3จะตอ้งพิจารณาในการนาเสนอเนืJอหาใหม่  

5. ชีJแนวทางการเรียนรู้ (Guide Learning) 

การชีJ แนวทางการเรียนรู้เป็นการใชใ้นชัJนเรียนตามปกติ ซึ3 งผูส้อนจะยกตวัอย่างหรือตัJงคาถามชีJแนะแบบ

กวา้ง ๆ ใหแ้คบลง เพื3อใหผู้เ้รียนวเิคราะห์เพื3อ คน้หาคาตอบ สิ3งที3จะตอ้งพิจารณาในการชีJแนวทางการเรียนรู้  

6. กระตุน้การตอบสนอง (Elicit Responses) 

การกระตุน้ใหเ้กิดการตอบสนองจากผูเ้รียน เมื3อผูเ้รียนไดรั้บการชีJแนวทางการเรียนรู้แลว้ ตอ้งมีการกระตุน้

ใหเ้กิดการตอบสนองโดยกิจกรรมต่าง ๆ สิ3งที3 ตอง้พิจารณาในการกระตุน้การตอบสนอง  

7. ใหข้อ้มูลยอ้นกลบั (Provide Feedback) 

หลงัจากที3ผูเ้รียนไดรั้บการทดสอบความเขา้ใจของตนในเนืJอหารวมทัJงการกระตุน้การตอบสนองแลว้ 

จาํเป็นอย่างยิ3งที3จะตอ้งให้ขอ้มูลยอ้นกลบัหรือการให้ผลกลบัไปยงัผูเ้รียนเกี3ยวกบัความถูกตอ้ง การให้ผล

ยอ้นกลบัถือเป็นการเสริมแรงอยา่งหนึ3ง การให้ขอ้มูลยอ้นกลบัสามารถแบ่งขัJนตอนไดเ้ป็น 4 ประเภทตาม

ลกัษณะที3ปรากฏได ้ 

8. ทดสอบความรู้ (Access Performance) 

การทดสอบความรู้หลงัเรียนเพื3อเป็นการประเมินผลว่าผูเ้รียนไดเ้กิดการเรียนรู้ไดต้ามเป้าหมายหรือไม่

อยา่งไร สิ3งที3ตอ้งพิจารณาในการออกแบบทดสอบหลงับทเรียน  

9. การจาํและนาํไปใช ้(Promote Retention and Transfer) 

สิ3งสุดทา้ยสําหรับการสอน การจาํและนาํไปใชสิ้3งสําคญัที3จะช่วยให้ผูเ้รียนมีความคงทนในการจาํขอ้มูล

ความรู้ ตอ้งทาํให้ผูเ้รียนตระหนักว่าขอ้มูลความรู้ใหม่ที3ได้เรียนรู้ไปนัJนมีความสัมพนัธ์กับความรู้เดิม                                          

หรือประสบการณ์เดิม 

 



 

 

บทที$3 

รายละเอยีดการปฏิบัตงิาน 

 

3.1 ชื$อและที$ตั8งของสถานประกอบการ 

 3.1.1 ชื#อสถานประกอบการ      การท่าเรือแห่งประเทศไทย                    

 3.1.2 ที#ตั:งสถานประกอบการ      เลขที# 444 ถนนท่าเรือ 

      แขวง คลองตนั เขต คลองเตย                              

      กรุงเทพฯ 10110 

      Phone: โทรศพัท:์ 02-269-3000 

      Website : www.port.co.th/ 

      Facebook : การท่าเรือแห่งประเทศไทย 

 

 

      

 

 

 

 

 

 

 

 

 

รูปที# 3.1.1 ตราสญัลกษัณ์ (Logo) การท่าเรือแห่งประเทศไทย 

 
 

 

 

 

 

 

 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

รูปที# 3.1.2 สถานที#ตั:งการท่าเรือแห่งประเทศไทย 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

รูปที# 3.1.3 แผนที#ตั:งการท่าเแห่งประเทศไทย 
 

 

 

 

 

 

 



 

 

3.2 ลกัษณะการประกอบการผลิตภณัฑก์ารใหบ้ริการหลกัขององคก์ร 

 การท่าเรือแห่งประเทศไทย (กทท.) เป็นรัฐวิสาหกิจสาธารณูปการในสังกดักระทรวงคมนาคม 

จดัตั:งขึ:นตามพระราชบญัญติัการท่าเรือแห่งประเทศไทยพ.ศ 2494 มีฐานะเป็นนิติบุคคลโดยมีวตัถุประสงค์

เพื#อจดัการดาํเนินการและนาํมาซึ# งความเจริญของกิจการท่าเรือฯ เพื#อประโยชน์แห่งรัฐและประชาชน โดย

กระทรวงคมนาคมเป็นหน่วยงานที#ทาํหน้าที#ควบคุมนโยบายการท่าเรือฯ และแผนพฒันาธุรกิจของการ

ท่าเรือฯ ใหเ้ป็นไปตามนโยบายของรัฐบาล มทั:งทาํหนา้ที#คดัเลือกคณะกรรมการบริหารการท่าเรือฯ 

 การท่าเรือมีหนา้ที#หลกัในการรับเรือและสินคา้ ขดุลอก บาํรุงรักษาร่องนํ:าทางเดินเรือและแต่งจอด

เรือควบคุมการขนถ่ายและบรรทุกสินคา้และตูสิ้นคา้ ยกขนเคลื#อนยา้ย เกบ็รักษา และส่งมอบใหแ้ก่เจา้ของ

สินคา้หรือเจา้ของตูสิ้นคา้ตลอดจนร่วมมือประสานงานกบัส่วนราชการและท่าเรือต่างประเทศ รวมทั:ง

พฒันาและปรับปรุงกิจการท่าเรือใหเ้จริญกา้วหนา้ทนัสมยัตามสภาวะเศรษฐกิจ 

 

วสัิยทศัน์ 

 " การท่าเรือแห่งประเทศไทย มุ่งสู่การเป็นประตูการคา้หลกัของประเทศที#ให้บริการเป็นเลิศ                       

และปลอดภยั เพื#อสนบัสนุนระบบเศรษฐกิจ และสามารถแข่งขนัในระดบัสากล"     

 

กองประชาสัมพนัธ์                                                               

มีหน้าที#ดาํเนินงานประชาสัมพนัธ์ ติดต่อประสานงานกับสื#อมวลชน ถ่ายภาพและภาพยนตร์                            

ตรวจข่าวสารและบทความที#เกี#ยวกับการท่าเรือแห่งประเทศไทย ซึ# งเผยแพร่ทางสื#อมวลชน แก้ข่าวที#

สื#อมวลชนเผยแพร่ผิดไปจากนโยบายและขอ้เท็จจริง ตอ้นรับและให้คาํชี: แจงแก่บุคคลภายนอกที#สนใจมา

เยี#ยมชมกิจการของการท่าเรือแห่งประเทศไทย รวบรวมสารคดีและข่าวสารที#เกี#ยวกบักิจการการท่าเรือแห่ง

ประเทศไทย  ออกเผยแพร่เพื#อประชาสมัพนัธ์ใหท้ราบทั#วกนั ประสานกบัหน่วยงานและองคก์รนานาชาติที#

การท่าเรือแห่งประเทศไทยเป็นสมาชิก ผลิตสื#อต่าง ๆ เพื#อการประชาสัมพนัธ์และเผยแพร่กิจการของ         

การท่าเรือแห่งประเทศไทย  

 

 

 

 

 

 

 

 

 



 

 

 

3.3 รูปแบบการจดัองคก์รและการบริหารขององคก์ร 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

คณะกรรมการ กทท. 

ผูอ้าํนวยการ กทท. 

นายสุรงค ์บูรกลุ 

ท่าเรือกรุงเทพ 

หวัหนา้ฝ่ายอาํนวยการ 

 

หวัหนา้กองประชาสมัพนัธ์ 

นางอุบลสิริ ศรีทองสุข 

 

หวัหนา้ แผนกผลิตสื#อ 

นายศานิต วชิพนัธ์ุ 

พนกังานที#ปรึกษา แผนกผลิตสื#อ 

นางสาวมนสันนัท ์วงษส์วสัดิ]  

ผูช่้วย แผนกผลิตสื#อ 

นางสาวญาดา เทียนศิริ 



 

 

 

3.4 ตาํแหน่งและลกัษณะงานที#นกัศึกษาไดรั้บมอบหมาย 

3.4.1 ตาํแหน่งที#นกัศึกษาไดรั้บมอบหมาย 

l  นางสาวญาดา  เทียนศิริ  ตาํแหน่ง  ผูช่้วยแผนกผลิตสื#อ 

3.4.2 ลกัษณะงานที#นกัศึกษาไดรั้บมอบหมายดาํเนินโครงงานนอกเหนือจากโครงงาน 

คือ การถ่ายภาพงานทั:งภายใน และภายนอกองคก์ร และออกแบบสื#อประเภทต่างๆ เขียนข่าว เพื#อลงทาง

เวบ็ไซต ์และทางเพจเฟสบุคหลกัของการท่าเรือแห่งประเทศไทย และจดักิจกรรมพิเศษต่างๆที#เกี#ยวขอ้ง 

รวมทั:งทาํ Spot เสียงตามสาย หาข่าว หาเพลงที#ตามกระแสเขา้กบัสถานการณ์ช่วงนั:นๆ  และอดัเสียงเพื#อเปิด

ภายในองคก์ร และจดัทาํสไลด ์Power point เพื#อนาํเสนองาน 

3.5 ชื#อ-สกลุ และตาํแหน่งของพนกังานที#ปรึกษา 

 3.5.1 ชื#อ-สกลุของพนกังานที#ปรึกษา      :     นางสาวมนสันนัท ์ วงษส์วสัดิ]  (อนั) 

 3.5.2 ตาํแหน่งของพนกังานที#ปรึกษา      :    เจา้หนา้ที#แผนกผลิตสื#อ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

รูปที#3.5.3 พนกังานที#ปรึกษา 
 

3.6 ระยะเวลาที#ปฎิบติังาน 

3.6.1 ระยะเวลาในการดาํเนินงาน วนัที# 14 พฤษภาคม 2561 - 31 สิงหาคม 2561 ( 16 สปัดาห์ ) 

3.6.2 วนัเวลาในการปฏิบติัสหกิจ วนัจนัทร์-วนัศุกร์ เวลา 8.30 น.- 16.30 น.  
 

 

 

 

 

 

 

 

 

 



 

 

3.7 ขั:นตอนและวธีิการดาํเนินงาน 
 

ระยะเวลา รายละเอยีดการปฏิบัติงานสหกจิ 

สปัดาห์ที# 1 ฟังคาํอธิบายงาน การทาํงานต่างๆ ของแผนกผลิตสื#อ จากพี#เลี:ยงวา่มี

หนา้ที#ทาํงานอยา่งไรบา้ง ตลอดการฝึกงานนี:  

สปัดาห์ที# 2 ถ่ายภาพ และแต่งภาพ ลงสื#อออนไลน์ Facebook , Website 

“ งานสถาปนาการท่าเรือ ครบรอบ 67 ปี ” 

สปัดาห์ที# 3 จดักิจกรรมพิเศษ “ Pat Network ” ทาํ Presentation เพื#อเปิดในงาน 

สปัดาห์ที# 4 ติดต่อประสานงาน โรงแรม สถานที#ต่างๆ เพื#อจดัสมัมนา 

สปัดาห์ที# 5 ออกแบบป้ายโฆษณาประชาสมัพนัธ์ “ Pat Innovation Award  ” เพื#อ

แจกและติดบริเวณโดยรอบ 

สปัดาห์ที# 6 ออกแบบงานเชิญชวนลงนามถวายพระพร พระเจา้อยูห่วัรัชกาลที# 10 

เพื#อลงสื#อออนไลน์ Facebook , Website ของการท่าเรือฯ 

สปัดาห์ที# 7 ออกแบบป้ายไวนิลขนาดใหญ่ โครงการ CSR ของการท่าเรือฯ   

“ Big Cleaning ร่วมใจชาวท่า อาสาทาํดี ” 

สปัดาห์ที# 8 ออกแบบป้ายไวนิลขนาดใหญ่ โครงการ CSR ของการท่าเรือฯ   

“ Big Cleaning ร่วมใจชาวท่า อาสาทาํดี ” ( แกไ้ขงาน) 

สปัดาห์ที# 9 ออกแบบใบปลิว โครงการ CSR ของการท่าเรือฯ   

“ Big Cleaning ร่วมใจชาวท่า อาสาทาํดี ” 

สปัดาห์ที# 10 ออกแบบป้ายไวนิล และใบปลิว งาน “ CG Day ” 

สปัดาห์ที# 11 ถ่ายภาพงาน “ Big Cleaning ร่วมใจชาวท่า อาสาทาํดี ” 

สปัดาห์ที# 12 ออกแบบป้ายโฆษณาประชาสมัพนัธ์งาน “ สปัดาห์รักษสุ์ขภาพ  ” 

สปัดาห์ที# 13 ออกแบบรูปงานเฉลิมพระชนมพรรษา 84 พรรษา ของพระนางเจา้

สิริกิติ]  เพื#อลงสื#อออนไลน์ Facebook , Website ของการท่าเรือฯ 

สปัดาห์ที# 14 ออกแบบ Presentation เพื#อนาํเสนอการไปจดักิจกรรมพิเศษภายใน

องคก์ร ที#จงัหวดัจนัทบุรี 

สปัดาห์ที# 15 เดินทางไปจดักิจกรรมพิเศษภายในองคก์รที#จงัหวดัจนัทบุรี เป็นเวลา     

2 วนั 1 คืน และดูแลความเรียบร้อย ประสานงานตลอดทั:งงาน 

สปัดาห์ที# 16 ออกแบบป้ายโฆษณาประชาสมัพนัธ์  

“ เชิญชวนร่วมประกวดผลงาน Reclycle ” 



 

 

 

3.8 อุปกรณ์และเครื#องมือที#ใช ้

3.8.1 อุปกรณ์ดา้นซอร์ฟแวร์ 

 -โปรแกรม Adobe Illustrator CS6 

3.8.2 อุปกรณ์ดา้นฮาร์ดแวร์ 

 - Notebook DELL Inspiron-2017 

 -กลอ้ง Canon EOS 80D



 

 

 



 

 

บทที$ 4 

ผลการปฏิบัตงิานตามรายงาน 

4.1 รายละเอยีดของรายงาน 

ผูจ้ ัดทาํได้อธิบายขั1นตอนการปฏิบัติงานเพื<อใช้ในการผลิตป้ายไวนิลเพื<อใช้ในการโฆษณา

ประชาสัมพนัธ์ โดยแบ่งเนื1อหาตามขั1นตอนการปฏิบติังานเพื<อให้เขา้ใจง่ายและสะดวกต่อการเปิดคน้หา

ข้อมูลได้ง่าย ซึ< งในแต่ละขั1นตอนจะอธิบายวิธีการทาํงานของโปรแกรม โดยยกตัวอย่างชิ1นงานที<ได้

ปฏิบติังานจริงส่วนหนึ<งเป็นรูปภาพเพื<อทาํใหเ้ขา้ใจง่ายยิ<งขึ1นโดยผูจ้ดัทาํขอเสนอผลงานโดยการยกตวัอยา่ง

ของชิ1นงานบางส่วนที<ไดท้าํในการฝึกงานสหกิจศึกษา 

สาํหรับการศึกษาขั1นตอนการใชโ้ปรแกรม Adobe Illustrator CS6 กบังานผลิตสื<อป้ายไวนิลเพื<อใช้

ในการโฆษณาประชาสมัพนัธ์ประเภทสิ<งพิมพ ์กรณีศึกษางาน “ Big Cleaning ” ของการท่าเรือแห่งประเทศ

ไทยมีขั1นตอนดงัต่อไปนี1  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

รูปที< 4.1 โปรแกรม Adobe Illustrator CS6 
 
 
 
 
 
 
 
 
 
 
 



 

 

4.2 ขั8นตอนการผลติสื$อ  

การผลิตสื<อโฆษณาประชาสัมพนัธ์ภายในหน่วยงานราชการมีความสาํคญัอยา่งมากในการสื<อสาร             

และให้ขอ้มูลข่าวสารต่างๆ ตอ้งผลิตสื<อโดยผ่านทางหน่วยงานราชการ จึงตอ้งมีการใชภ้าษาอย่างถูกตอ้ง          

และระมดัระวงัการใชภ้าษาเป็นอย่างมาก รวมทั1งตอ้งใชรู้ปภาพที<สวยงามเพื<อที<จะดึงดูดให้ผูพ้บเห็นเกิด

ความสนใจ และในบางงานเป็นการให้ข้อมูลข่าวสารจากหน่วยงานราชการถึงประชาชน ยิ<งต้องให้

ความสาํคญัในการใชภ้าษาและรูปภาพมากขึ1น เพราะประชาชนในพื1นที<นั1นยงัขาดความรู้ความเขา้ใจในตวั

สาร หรือสาระสาํคญัที<หน่วยงานราชการตอ้งการส่งถึงประชาชน เช่น การรณรงคที์<หน่วยงานราชการจดัทาํ

ให้ประชาชน, สิทธิประโยชน์ต่างๆ  การเลือกตั1ง หรือขอ้มูลต่างๆที<น่าสนใจ ณ ขณะนั1นๆ เช่นโรคต่างๆที<

ควรระวงั, ภยัอนัตรายใกลต้วั 

 

4.2.1 ขั8นตอนการรับรายละเอยีดงานจากหัวหน้ากองประชาสัมพนัธ์ และแผนงานที$จะจัดทาํ  

ขั1นตอนการปฏิบติังานขั1นตอนที<หนึ<ง ผูจ้ดัทาํตอ้งถามถึงขอ้บงัคบัต่างๆ และขอ้จาํกดัของการทาํงาน           

ชิ1นนั1นๆ และตอ้งการเผยแพร่ถึงใคร และสถานที<ที<ตอ้งการเผยแพร่ชิ1นงาน  

งานที<ยกมาประกอบคือ หัวขอ้งาน “Big cleaning จดักิจกรรมเนื<องในวนัเฉลิมพระชนมพรรษา            

สมเด็จพระเจา้อยู่หัว 66 พรรษา” เป็นโครงการ CSR (แนวคิดที<องค์กรผสานความห่วงใยต่อสังคมและ

สิ<งแวดลอ้มไวใ้นกระบวนการดาํเนินธุรกิจและการมีปฏิสมัพนัธ์กบัผูมี้ส่วนไดเ้สียภายใตพื้1นฐานการกระทาํ

ดว้ยความสมคัรใจ) ทาํชิ1นงานรวมทั1งหมด 12 ชิ1น แบ่งเป็น ติดภายในองค์กรที<ทาํการ 8 ชิ1น และบริเวณ

ชุมชนโดยรอบ 4 ชิ1น  

ขอเสนอขั1นตอนผลิตสื<อโฆษณาประชาสัมพนัธ์โดยจากสิ< งที<บังคับที<จะต้องมีในชิ1นงาน คือ                                 

โลโก้การท่าเรือแห่งประเทศไทย (รูปที<4.2.1.1)  รูปคนปลูกต้นไม้ (รูปที<4.2.1.2)  รูปคนเก็บขยะ 

(รูปที<4.2.1.3)   และรูปเรือขนาดใหญ่ (รูปที<4.2.1.4)   

 

 

 
 
 
 
 
 
 
 

 
 
 

      รูปที< 4.2.1.1 โลโกก้ารท่าเรือแห่งประเทศไทย  

 



 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
รูปที< 4.2.1.2 รูปคนปลูกตน้ไม ้

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

รูปที< 4.2.1.3 รูปคนเกบ็ขยะ 

 
 
 
 
 
 
 
 
 
 
 
 

รูปที< 4.2.1.4 รูปเรือขนาดใหญ่ 

 

 



 

 

4.2.2 ขั8นตอนการผลติสื$อโฆษณาประชาสัมพนัธ์ 

 เขา้ร่วมประชุมกบัพี<พนกังานที<ไดรั้บมอบหมายจากหวัหนา้แผนก (รูปที< 4.2.2.1) เพื<อรับทาบถึงการ

ดาํเนินการจดัทาํ  ไวนิลขนาดใหญ่ชิ1นนี1  ว่าตอ้งการที<จะมีรูปแบบใด และตอ้งการอะไรในชิ1นงานบา้ง 

รวมทั1 งจะนําไปโฆษณาประชาสัมพนัธ์ที<ไหน และกลุ่มเป้าหมายที<ต้องการสื<อสารถึงเป็นกลุ่มใดบ้าง 

เพื<อที<จะทาํชิ1นงานใหเ้หมาะสม กบัสถานที< และกลุ่มเป้าหมายนั1นๆ  
 

 

 

 

 

 

 

 

 

 

 

 

 

       รูปที< 4.2.2.1 เขา้ประชุม เพื<อทราบถึงการดาํเนินจดัทาํชิ1นงาน 

 

 จากนั1นก็นาํไปคุยกบัพี<เลี1ยงที<ปรึกษา เพื<อให้ช่วยคิดแนวทางในการจดัทาํ ก่อนที<จะเริ<มดาํเนินการ

จดัทาํไวนิลขนาดใหญ่ เพื<อที<จะไดแ้นวคิดเพิ<มเติมในการสร้างสรรค์ผลงาน และทราบถึงขอ้จาํกดัของ

ชิ1นงาน เพราะเป็นหน่วยงานราชการ จะมีขอ้บงัคบั หรือขอ้ที<จะตอ้งนาํลงชิ1นงานที<เราอาจจะยงัไม่ทราบอีก

ดว้ย (รูปที< 4.2.2.2) 

 

 

 

 

 

 

 

 



 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 

 
รูปที< 4.2.2.2 ปรึกษาพี<เลี1ยงเพิ<มเติม  

 

 และเมื<อประชุมกบัพี<พนกังานที<มอบหมายงาน และปรึกษากบัพี<เลี1ยงเพิ<มเติม ก็ดาํเนินการร่างแบบ

ออกมาก่อนที<จะลงมือทาํจริงๆ (รูปที< 4.2.2.3)  เพื<อให้การทาํชิ1นงาน มีการจดัดระเบียบที<ง่ายขึ1น และเสร็จ

รวดเร็วขึ1น 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

รูปที< 4.2.2.3 ตวัอยา่งที<ร่างไวก่้อนลงมือทาํ 
 
 
 
 
 
 
 
 



 

 

 เริ< มลงมือออกแบบไวนิลขนาดใหญ่ (รูปที< 4.2.2.4) โดยเปิดโปรแกรม Adobe illustrator cs6 

ขึ1นมา (รูปที< 4.2.2.5) และเริ<มดาํเนินการดงัตวัอยา่งชิ1นงานที<จะอธิบายขั1นตอนเป็นขั1นตอน ดงัต่อไปนี1   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

รูปที< 4.2.2.4 เริ<มดาํเนินการจดัทาํชิ1นงาน 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

รูปที< 4.2.2.5 โปรแกรม Adobe illustrator cs6  
 
 
 
 
 
 



 

 

 เมื<อเปิดเขา้หนา้โปรแกรม Adobe Illustrator CS6 จะพบหนา้ต่างเปล่าๆขึ1นมา ให้คลิก File > New             

เพื<อกาํหนดขนาดของชิ1นงาน และประเภทของงาน กาํหนดขนาด กวา้ง 300 ซม. และยาว 150 ซม. เลือกรูป

เป็นแนวนอน กําหนดค่าสีเป็น CMYK (รูปที< 4.2.2.6) หลังจากนั1 นจะได้ขนาดของกระดาษชิ1นงานที<              

กาํหนดไว ้ (รูปที< 4.2.2.7) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

รูปที< 4.2.2.6 หลงัจากคลิก File > New มีช่องใหก้าํหนดขนาด และประเภทของชิ1นงาน 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

รูปที< 4.2.2.7 หนา้กระดาษที<กาํหนดค่าเสร็จเรียบร้อย 
 
 
 
 

กาํหนดขนาด 
กาํหนดประเภท 



 

 

 จากนั1นเริ<มทาํในส่วนของพื1นหลงั ชิ1นงานตอ้งการความดึงดูดน่าสนใจและเขา้ใจง่าย จึงจะทาํชิ1นงาน             

ใหมี้สีสนัและมีความน่ารักสดใส จึงเลือกสีพื1นหลงัสีฟ้า โดยไปที< File > Open แลว้เลือกภาพที<ตอ้งการนาํมา

วางแลว้จดัหนา้ให้พอดี (รูปที< 4.2.2.8) แต่การทาํไวนิลมีขนาดใหญ่มากจึงตอ้งใชพื้1นหลงัที<มีความละเอียด

สูงมาก เพราะชิ1นงานมีขนาดใหญ่ ไม่เช่นนั1นชิ1นงานจะมีความแตกเพราะภาพไม่คมชดั และจะทาํใหชิ้1นงาน

ไม่สวยงาม 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

รูปที< 4.2.2.8 ใส่พื1นหลงัที<มีความละเอียดสูง 

 

ต่อไปเป็นขั1นตอนของการออกแบบ ไดดู้จากตวัอยา่งที<ไดร่้างแบบไว ้ตอ้งการใหมี้ทั1งพื1นดินและนํ1า              

จึงนาํรูปมาจากเวบ็ที<ทาํการโหลดออนไลน์  นาํมาดดัแปลงและใชค้วามคิดสร้างสรรคใ์นการผลิตชิ1นมา โดย

กดนาํไฟล์ภาพที<ไดโ้หลดไว ้โดยไปที< File > Open แลว้เลือกภาพที<ตอ้งการนาํมาวาง และส่วนของการ

ปรับแต่งยอ่ขยายภาพ ใชเ้ครื<องมือลูกศรสีดาํ(Selection tool) ทางดา้นซา้ยมือ (รูปที< 4.2.2.9) 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

รูปที< 4.2.2.9 เครื<องมือที<ใชใ้นการออกแบบ  

 

** ทุกครั1 งที<ทาํการยอ่ขยาย จะตอ้งกด Shift พร้อมลากเมา้ส์  

เพื<อเป็นการรักษาสมดุลของภาพไม่ใหเ้สียรูปทรง ** 

 

 เริ< มทาํการใส่ภาพตกแต่งวตัถุที<ต้องการลงไปในชิ1นงาน ใส่ส่วนที<บงัคบัที<จะต้องมีในชิ1นงาน            

คนปลูกตน้ไม  ้และคนเก็บขยะ (รูปที< 4.2.2.10) หลงัจากนั1นใส่คาํเชิญชวญที<ได้เตรียมไวล้งไป โดยใช้

เครื<องมือสร้าง กรอบขอ้ความ Basic shape tool (เอาไวว้าดรูปทรงพื1นฐาน) และเครื$องมือ Type tool  เอาไว้

พิมพข์อ้ความ (รูปที< 4.2.2.11) 

 

** หากตอ้งการใหว้ตัถุไปอยูด่า้นหลงั ใหค้ลิกขวาวตัถุที<ตอ้งการ > Arrange > Send to Back ** 

 
   
 
 
 
 
 
 
 
 
 

Selection tool 

ZOOM 



 

 

 
 

รูปที< 4.2.2.10 ใส่รูปภาพบงัคบั 

รูปที< 4.2.2.11 การสร้างกรอบขอ้ความ และพิมพต์วัหนงัสือ 

 

 

 

 

 

 

Type tool  



 

 

 ชิ1นงานมีความโล่งตรงกลางเลยใส่รูปภาพเรือขนาดใหญ่ ซึ< งเป็นสัญลกัษณ์ของการท่าเรือแห่ง

ประเทศไทย เป็นรูปภาพบงัคบั แต่รูปภาพมีความสีฉูดฉาด จึงปรับให้ภาพจางลงเพื<อให้มีความเสมือนจริง

มากขึ1น (รูปที< 4.2.2.12) แลว้ก็ตกแต่งเพิ<มเติมเอให้ชิ1นงานมีความสดใส น่ารัก และน่าอ่านมากขึ1นดว้ยการ

เพิ<ม กอ้นเมฆ นก ปลา ลงไปในชิ1นงาน  

 ตรวจความเรียบร้อยของชิ1นงาน ใหพี้<เลี1ยงและผูอ้าํนวยการกอง ที<เป็นผูส้ั<งทาํตรวจสอบในขั1นตอน

สุดทา้ย (รูปที< 4.2.2.13) และหากมีการแกไ้ข ก็แกไ้ขให้เรียบร้อย หากผ่านจากการตรวจชิ1นงานแลว้ จึงจะ

เซฟเพื<อส่งทาํป้ายไวนิลในขั1นตอนถดัไป(รูปที< 4.2.2.14) 

 

** วธีิทาํใหภ้าพมีสีจางลง ใหค้ลิกที<ภาพที<ตอ้งการและปรับ Opacity ใหเ้หลือ 50%  

ปรับไดที้<แทบเครื<องมือดา้นขวา **  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
รูปที< 4.2.2.12 ปรับแสงที<เรือขนาดใหญ่ใหจ้างลงเหลือ 50% 

 
 
  



 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

รูปที< 4.2.2.13 นาํไปใหห้วัหนา้แผนกตรวจสอบ  

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

รูปที< 4.2.2.14 ชิ1นงานที<ผา่นการตรวจสอบแลว้ 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

4.2.3 ขั8นตอนการบันทกึและจัดเกบ็ภาพ 

การเซฟชิ1นงานมี ใหค้ลิกไปที<คาํสั<ง File > Save As และตั1งชื<อไฟล ์พร้อมกด Save (สกลุไฟล ์AI) แต่หาก

ตอ้งการเซฟเป็นรูปภาพ ตอ้งใชค้าํสั<ง File > Export > เลือกสกลุไฟล ์

 

 

 

 

 

 

 

 

 

 
 
 
 
 
 
 
 

รูปที< 4.2.3.1 เซฟงานเป็นไฟล ์AI 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
รูปที< 4.2.3.2 ชิ1นงานที<สาํเร็จแลว้ และนาํไปใชจ้ริง ถูกติดตามอาคารสาํนกังานที<ทาํการ และบริเวณโดยรอบ 
 



 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

รูปที< 4.2.3.3 ชิ1นงานถูกนาํไปโฆษณาประชาสมัพนัธ์ในลิฟททุ์กตวัในองคก์ร 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

บทที$ 5 

สรุปผลและข้อเสนอแนะ 

 

5.1 สรุปผลการปฏิบัตงิานสหกจิศึกษา 

จากการปฏิบติัหนา้ที0ผูช่้วยแผนกผลิตสื0อ ที0การท่าเรือแห่งประเทศไทยเป็นระยะเวลา 16 สัปดาห์ 

ตัDงแต่วนัที0 14 พฤษภาคม 2561 ถึงวนัที0 31 สิงหาคม 2561 ได้รับมอบหมายให้ปฏิบติัหน้าที0ตกแต่งและ

ออกแบบ รวมถึงถ่ายภาพงานที0เกี0ยวขอ้งในการท่าเรือแห่งประเทศไทย เพื0อนาํมาลง สื0อออนไลน์ Facebook 

Website และสื0อประเภทสื0อสิ0งพิมพ ์ทาํให้ไดรั้บประสบการณ์ใหม่ในการใชโ้ปรแกรมแต่งภาพและตดัต่อ

ภาพ และไดเ้รียนรู้ระบบการทาํงานของหน่วยงานราชการ ไดรู้้จกัการทาํงานร่วมกบัผูอื้0น และไดใ้ชศ้กัยภาพ

ในการที0ไดเ้ล่าเรียนมาใชไ้ดอ้ยา่งเต็มที0 ทาํให้การทาํงานมีประสิทธิภาพมากขึDน และมีความรับผิดชอบใน

หนา้ที0มากขึDน และฝึกใหเ้ป็นคนที0มีความรับผดิชอบตรงต่อเวลา เพราะวา่งานราชการมีการเขา้ออกอยา่งเป็น

ระบบ 

ในการปฏิบติังานสหกิจศึกษาได้ใช้ความรู้ความสามารถในด้านการถ่ายภาพตกแต่งภาพ และ

ออกแบบสื0ออย่างเต็มที0 โดยใชค้วามรู้พืDนฐานจากประสบการณ์ในการศึกษามาใชป้ฏิบติังานจริง รวมถึง

คาํแนะนาํจากพนักงานที0ปรึกษาที0คอยให้คาํแนะนาํในการถ่ายภาพและการออกแบบตกแต่ง เพื0อลงสื0อ

โฆษณาออนไลน์ ซึ0 งในการปฏิบติั ไดรับคาํติชมจากผูมี้ประสบการณ์ทางดา้นการกราฟิก ภายในองคก์ร และ

ไดรั้บคาํแนะนาํดีๆ ซึ0 งเป็นสิ0งที0น่าภูมิใจอยา่งมาก และสามารถนาํเอาคาํติชมมาปรับปรุงและพฒันาความรู้

ความสามารถให้ผูจ้ดัทาํมีประสิทธิภาพในดา้นการถ่ายภาพและตกแต่งภาพเพิ0มมากขึDน นอกจากนีD ยงัมี

อุปสรรคในการปฏิบติังานคือ การที0เราตอ้งทาํงานร่วมกบัคนหมู่มากทัDงภายในองค์กรและนอกองค์กร 

รวมถึงตอ้งประสานงานกบัส่วนอื0นๆ ทัDงภายในและภายนอกนอกองคก์ร ทาํใหเ้ราตอ้งมีความเป็นมืออาชีพ 

มีความรับผิดชอบ และมีความอดทนอยา่งสูงในการทาํงาน เพราะเราไปทาํงานในฐานะฝ่ายผลิตสื0อ ซึ0 งถือ

เป็นตวัแทนขององคก์ร ซึ0 งการทาํงานอยา่ง มืออาชีพจะส่งผลต่อภาพลกัษณ์ที0ดีของตวัองคก์รดว้ย 

 

5.2 ข้อเสนอแนะการปฏิบัตงิานสหกจิศึกษา  

5.2.1 งานที0ไดรั้บมอบหมายเป็นการดาํเนินงานจริงนาํไปใชจ้ริง และตอ้งทาํงานร่วมกบัคนหมู่มาก

จึงจะตอ้งดาํเนินงานอยา่งเป็นระบบระเบียบมีแผนการทาํงานอยา่งเป็นขัDนตอน ตอ้งมีความกระตือรือร้น มี

ความรับผดิชอบต่องานที0ไดรั้บมอบหมายจากพี0เลีDยงจึงตอ้งหมั0นพฒันาตวัเองอยา่งสมํ0าเสมอ 

5.2.2 ความมีความรอบคอบในการทาํงานดา้นการออกแบบตกแต่งภาพ เราตอ้งมีความรอบคอบใน

การตรวจสอบและเช็คคุณภาพของงานทุกครัD ง เพราะการที0ผลงานไดแ้สดงออกไปทางสื0อออนไลน์ แลว้ถา้มี

ความผดิพลาดเกิดขึDนจากการขาดความรอบคอบกอ็าจส่งผลต่อความเชื0อมั0นของบริษทัได ้

 

 



 

 

5.3 สรุปผลรายงานการจัดทาํรายงานสหกจิศึกษา  

5.3.1 เพื0อการศึกษาขัDนตอนการออกแบบสื0อผา่นสื0อออนไลน์ Facebook Website โดยใชโ้ปรแกรม 

illustrator และโปรแกรม Photoshop   

5.3.2 เพื0อลงมือปฏิบติังานจริง งานจะเริ0มจากการประชุมเพื0อรับโจทย ์จากพนกังานที0ปรึกษา ศึกษา

ขอ้มูล และลงมือปฎิบติั  

 5.3.3 เพื0อใหท้ราบถึงปัญหาและอุปสรรคในการปฏิบติังานและสามารถแกไ้ขปัญหาที0เกิดขึDน โดย

สรุปผลวา่ ปัญหาจากการปฏิบติังานในครัD งนีD คือการตรวจงานแต่ะครัD ง ใชเ้วลานานในการตรวจสอบ เพราะ

เป็นหน่วยงานราชการ จึงมีขอ้บงัคบัในการทาํงานอยูด่ว้ย 

 

5.4 ข้อเสนอแนะการจัดทาํรายงานสหกจิศึกษา 

5.4.1 ในการทาํเล่มโครงงานสหกิจศึกษามกัจะประสบปัญหาในเรื0องของรูปแบบและการจดัหนา้                 

ของรายงาน ทาํให้เกิดปัญหาที0ตอ้งคอยแก้ไขอยู่ตลอด ดงันัDนเราตอ้งใช้ความละเอียดอย่างมากในการ

ตรวจสอบรูปแบบของเล่มโครงงานสหกิจศึกษาใหถู้กตอ้งตามที0มหาวทิยาลยักาํหนด 
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